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Вступ 
 

Методичні вказівки розроблено для проведення Практичної роботи 
№1 «Статичний аналіз напружено-деформованого консольного 
стального стержня» з курсу: «Метод скінченних елементів в механіці 
споруд» для студентів спеціальності 7.06010101 та 8.06010101 
«Промислове і цивільне будівництво» денної і заочної форми 
навчання. Вони виконані згідно мети та завдань курсу. 

 
1. Ціль практичної роботи 

 
Використовуючи програмний комплекс ANSYS Multiphysics: 

оволодіти методикою створення тривимірної параметричної моделі 
стержня, в препроцесорі задати механічні властивості матеріалу, 
згенерувати сітку скінченних елементів; в процесорі задати 
навантаження і виконати розрахунок напружено-деформованого 
стану; в постпроцесорі виконати аналіз результатів розрахунку, 
побудувати криві розподілу напружень та деформацій 
 

2. Опис стального стержня і навантаження 
 

Геометричні розміри стержня задаються відповідно до варіанту 
(табл. 1). Один кінець стержня жорстко закріплений. До 
протилежного кінця прикладаються вертикальні зусилля. Розрахунок 
у пружній постановці. 

Властивості матеріалу (сталі): модуль Юнга (пружності) Е = 2⋅105 

МПа; коефіцієнт Пуассона µ = 0,3. 
 

Таблиця 1. Геометричні розміри стального стержня 

№ 
варіанту 

Довжина l, м. Ширина b, м Висота h, м 

1 2 3 4 
 

l 

h 

b 

 
1.  0,50 0,030 0,020 
2.  0,52 0,031 0,021 
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Продовження табл. 1 

1 2 3 4 
3.  0,54 0,032 0,022 
4.  0,56 0,033 0,023 
5.  0,58 0,034 0,024 
6.  0,60 0,035 0,025 
7.  0,62 0,036 0,026 
8.  0,64 0,037 0,027 
9.  0,66 0,038 0,028 
10.  0,68 0,039 0,029 
11.  0,70 0,040 0,030 
12.  0,72 0,041 0,031 
13.  0,74 0,042 0,032 
14.  0,76 0,043 0,033 
15.  0,78 0,044 0,034 
16.  0,80 0,045 0,035 
17.  0,82 0,046 0,036 
18.  0,84 0,047 0,037 
19.  0,86 0,048 0,038 
20.  0,88 0,049 0,039 
21.  0,90 0,050 0,040 
22.  0,92 0,051 0,041 
23.  0,94 0,052 0,042 
24.  0,96 0,053 0,043 
25.  0,98 0,054 0,044 
26.  1,00 0,055 0,045 

 
3. Завдання 

 
Шляхом покрокового навантаження моделі стержня визначити 

зусилля, при якому у найбільш напруженому перерізі стержня 
інтенсивність напружень досягає σint = 200 МПа. 

Проаналізувати поля переміщень, напружень та деформацій 
стержня. 

Побудувати криві розподілу розтягуючих напружень та 
деформацій вздовж верхньої горизонтальної грані стержня. 
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4. Звіт 
 

Звіт про виконання практичної роботи повинен містити: короткий 
опис отриманих результатів; екранні копії полів переміщень, 
напружень та деформацій стержня; криві розподілу розтягуючих 
напружень та деформацій вздовж верхньої горизонтальної грані 
стержня. 

 
5. Порядок виконання роботи 

 
5.1 Вибір типу графічного інтерфейсу 

 
У вікні меню Preferences ставимо помітку навпроти Structural 

(рис. 1). 
 

 
 

Рис. 1. Вибір типу графічного інтерфейсу Structural 
 

5.2 Вибір тривимірного скінченного елемента 
 
У меню Preprocessor>Element Type>Add/Edit/Delete натискаємо 

кнопку ADD і у вікні Library of Element Types вибираємо 
тривимірний 8-ми вузловий елемент Brick 8 node 185 і натискаємо 
кнопку ОК (рис. 2). 
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Рис. 2. Вибір тривимірного скінченного елемента Solid185 

 
5.3 Задання механічних властивостей матеріалу 

 
Відкриваємо меню визначення властивостей матеріалу – 

Preprocessor>Material Props>Material Models. У вікні Define Material 
Model Behavior вибираємо модель пружного ізотропного матеріалу 
Structural>Linear>Elastic>Isotropic і у вікні Linear Isotropic Material 
Properties for Material Number 1 вписуємо модуль Юнга EX та 
коефіцієнт Пуассона PRXY (рис. 3). 

 
Рис. 3. Задання механічних властивостей матеріалу стержня 
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5.4 Побудова геометричної моделі стержня 
 
Для прикладу обраний варіант №26 
 
З використанням меню Preprocessor>Modeling>Create>Keypoints> 

In Active CS у вікні Create Keypoints in Active….. (рис. 4) створюємо 
чотири ключові точки торцевої поверхні стержня з координатами: 

NPT Keypoint Number 1 
X, Y, Z Location …  0 0 0 

NPT Keypoint Number 2 
X, Y, Z Location …  0.055 0 0 

NPT Keypoint Number 3 
X, Y, Z Location …  0.055 0.045 0 

NPT Keypoint Number 4 
X, Y, Z Location …  0 0.045 0 

Після створення кожної точки натискаємо OK. 

 
Рис. 4. Створення ключових точок торцевої поверхні стержня 

 
З використанням меню Preprocessor>Modeling>Create>Lines> 

Straight Line створюємо прямі лінії між точками. Для створення 
однієї лінії, почергово мишкою вибираємо 2 сусідні точки, наприклад 
1 та 2 і натискаємо Apply. Аналогічно створюємо решту 3 лінії (рис. 5). 
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Рис. 5. Створення ліній – ребер торцевої грані стержня 

 
З використанням меню Preprocessor>Modeling>Create>Areas> 

Arbitrary>By Lines з допомогою мишки, послідовно (за, або проти 
годинникової стрілки), відмічаємо всі чотири лінії і натискаємо ОК 
(рис. 6 а). У результаті отримаємо поверхню (рис. 6 б). 

 
а) 
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б) 

 
Рис. 6. Створення поверхні торцевої грані стержня на основі чотирьох 

ліній 
 
Зауваження! Не забуваємо періодично записувати проект на 

жорсткий диск. У Ansys відсутня функція відміни кроків. 
Використовуючи меню Preprocessor>Modeling>Operate>Extrude> 

Areas>Along Normal відкриваємо вікно команди витягування 
поверхні вздовж нормалі до неї Extrude Area by Norm. Нормаллю до 
поверхні торця, яка знаходиться у площині OXY є вісь OZ. Мишкою 
виділяємо поверхню для витягування (рис. 7 а) і натискаємо Apply. 
Після цього з'явиться вікно Extrude Area along Normal (рис. 7 б) в 
якому у вікні DIST Length of Extrusion вписуємо віддаль витягування. 
В даному випадку – 1 м. Тобто витягування відбудеться у від'ємному 
напрямку осі OZ. Це зроблено з метою залишити початок координат у 
площині поверхні витягування. 

а) 
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б) 

 
 
в) 

 

 
Рис. 7. Створення об'єму стержня: 

а) виділення торцевої поверхні для витягування вздовж осі OZ; 
б) задання довжини стержня для витягування вздовж осі OZ; 

в) створений об'єм стержня шляхом витягування торцевої поверхні 
вздовж осі OZ на 1 м 

 
Після натискання OK, програма створить об'єм стержня із 

заданими розмірами (рис. 7 в). 
 
5.5 Дискретизація моделі скінченними елементами SOLID185 
 
Створений об'єм стержня (рис. 7 в) необхідно дискретизувати, 

тобто розбити на скінченні елементи (SOLID185), які володіють всіма 
необхідними для моделювання напружено-деформованого суцільного 
об'єму характеристиками. 

Використовуючи меню Preprocessor>Meshing >Size Cntrls>Manual 
Size>Global>Size у вікні Global Element Sizes задаємо розмір 
скінченного елемента, у вікні Size Element Edge Length вписуємо 
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розмір 0,01 м, тобто 1 см (рис. 8). Натискаємо ОК. 
В цілому, точність розрахунку залежить від ступеня дискретизації. 

Чим менший розмір елемента, тим точніший розрахунок. Проте, 
надто значне зменшення розмірів елементів може призвести до 
значного збільшення машинного часу розрахунку і, в окремих 
випадках, до зменшення точності обчислень. 

Особливостям розбивки моделі на скінченні елементи присвячений 
окремий розділ методичних матеріалів дисципліни. 

У нашому випадку розмір елемента 0,01 м є достатнім. 
 

 

 

Рис. 8. Задання розмірів (віддалі між вузлами) скінченних елементів 
 
Обираємо меню для розбивки об'єму на скінченні елементи із 

вказаними вище розмірами Preprocessor>Meshing 
>Mesh>Volumes>Mapped>4 to 6 sided (рис. 9). Виділяємо об'єм 
стержня мишкою і натискаємо OK.  

Команда Mapped>4 to 6 sided дає змогу розбити об'єм на 
"регулярну", тобто впорядковану сітку. На відміну від вільної Free 
розбивки, регулярна сітка дає точніші результати обчислень. 

У результаті виконання вказаної команди програма розіб'є об'єм 
стержня на скінченні елементи (рис. 10). 
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Рис. 9. Дискретизація об'єму на скінченні елементи регулярною 

(Mapped) скінченноелементної сіткою 
 

 
Рис. 10. Дискретизований скінченними елементами об'єм стержня 
 

5.6 Задання навантажень 
 
Отриману скінченноелементну модель стержня (рис. 10) необхідно 

навантажити. Для цього слід консольно закріпити торцеву поверхню, 
тобто обмежити її у переміщеннях вздовж всіх осей. 
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Для цього використовується команда меню Solution>Define 
Loads>Apply>Structural> Displacement > On Areas (рис. 11 а). Після 
появи вікна Apply U,ROT on Areas потрібно виділити мишкою 
торцеву поверхню стержня (рис. 11 а) і натиснути OK. Після цього, у 
вікні (рис. 11 б) відмітити All DOF і навпроти Value Displacement 
value вписати 0 і натиснути OK. 

 
а) 

 
 
б) 

 

 
Рис. 11. Консольне закріплення торцевої поверхні стержня: 

а) виділення поверхні для обмеження (фіксації) переміщень у всіх 
напрямках; б) задання обмежень переміщень виділеної поверхні у всіх 

напрямках (All DOF = 0) 
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Таким чином, ми отримали скінченноелементну модель консольно-
закріпленого стального стержня. 

Наступним кроком є навантаження протилежної частини стержня 
вертикальними зусиллям, направленим "вниз", тобто протилежно 
напрямку осі OY. 

Для цього використовуємо пункт меню Solution>Define 
Loads>Apply>Structural>Force/Moment>On Nodes і виділяємо 
мишкою вузол посередині верхнього ребра протилежної торцевої 
поверхні стержня (рис. 12 а). Натикаємо ОК. 

а) 

 
б) 

 
Рис. 12. Навантаження вузла верхнього ребра протилежної торцевої 

поверхні стержня зусиллям 5000 Н, або 0,005 МН 
 
У вікні Apply F/M on Nodes (рис.12 б) слід вказати напрямок 

зусилля FY і значення зусилля VALUE Force/moment Value у 
меганьютонах, оскільки модуль пружності матеріалу ми задавали у 
мегапаскалях. У нашому випадку зусилля у 500 Кг = 5000Н = 
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0,005МН. 
Вписуємо значення (– 0,005) із знаком "-", оскільки зусилля 

повинно бути спрямоване проти осі OY (рис. 12 б) і натискаємо ОК. 
 
Увага! При заданні навантажень необхідно дотримуватись 

розмірностей! 
 

5.7 Розрахунок 
 

На даному етапі скінченноелементна модель стержня є 
навантаженою. Наступним кроком є розрахунок напружено-
деформованого стану. 

Для виконання поставленої задачі – визначення зусилля, при якому 
у найбільш напруженому перерізі стержня інтенсивність напружень 
досягає σint = 200 МПа необхідно здійснити покрокове навантаження 
моделі стержня, тобто розділити навантаження на декілька підкроків, 
наприклад на 10 (рис. 13). 

 
Рис. 13. Встановлення опцій розбиття кроку навантаження на 

підкроки 
 
Для цього використаємо пункт меню Solution>Analysis Type>Sol'n 

Controls, у якому встановимо такі опції: 
- великих переміщень Analysis Options – Large Displacement; 
- час завершення кроку Time at the end of loadstep – 1; 
- автоматичне розбиття на підкроки Automatic time stepping – On; 



 17

- ставимо відмітку навпроти Number of substeps; 
- встановлюємо кількість підкроків Number of substeps – 10; 
- максимальна кількість підкроків Max no. of substeps – 50; 
- мінімальна кількість підкроків Min no. of substeps – 10; 
- запис результатів у пам'ять після кожного підкроку Frequency – 

Write every substep. 
Натискаємо OK. 
Для початку розрахунку вибираємо пункт меню 

Solution>Solve>Current LS. Натискаємо ОК (рис. 14). 

 
Рис. 14. Початок розрахунку 

 
Після завершення розрахунку на екрані з'явиться вікно з 

повідомленням Solution is done (рис. 15). 

 
Рис. 15. Повідомлення про завершення розрахунку 
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5.8 Виведення результатів розрахунку 
 

Для перегляду результатів розрахунку в Ansys передбачено велика 
кількість опцій. Зручним для візуального відображення результатів є 
модуль перегляду меню постпроцесора General Postprog>Results 
Viewer (рис. 16). 

 
Рис. 16. Виклик програми перегляду результатів Results Viewer 

 
У вікні Results Viewer міститься увесь набір опцій для перегляду 

результатів розрахунку складного напружено-деформованого стану: 
переміщення, напруження, деформації, тощо. 

Для прикладу вибираємо інтенсивність напружень Stress intensity і 
натискаємо  (рис. 17). 

 
Рис. 17. Вибір результатів розрахунку інтенсивності напружень Stress 

intensity 
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Повзунком (рис. 18) можна вибрати підкрок навантаження. 

 
Рис. 18. Вибір підкроку навантаження 

 
На першому підкроці навантаження (500 Н) максимальні 

напруження сягають 26,759 МПа (рис. 19). 

 
Рис. 19. Результати (поле напружень) розрахунку інтенсивності 

напружень на першому підкроці навантаження 
 
Переміщуючи повзунком підкроки навантаження у бік їх 

збільшення видно, що напруження у стержні зростають. Найбільші 
напруження виникають у місці консольного закріплення на верхній та 
нижній гранях стержня. На восьмому підкроці навантаження (4000 Н) 
напруження вже перевищують 200 МПа (рис. 20). Тобто, згідно 
поставленої умови задачі, максимальне прикладене зусилля не 
повинне перевищувати 4000 Н. 



 20

 
Рис. 20. Результати (поле напружень) розрахунку інтенсивності 

напружень на восьмому підкроці навантаження, коли вони 
перевищують 200 МПа 

 
5.9 Виведення кривих розподілу напружень (деформацій, 

переміщень) вздовж деякої наперед визначеної лінії 
 
Використовуючи пункт меню PlotCtrls>Elements виводимо на 

екран скінченноелементну модель стержня (рис. 21). 

 
Рис. 21. Виведення на екран скінченноелементної моделі стержня 



 21

Зчитуємо результати розрахунку на восьмому підкроці 
навантаження використовуючи General Postproc>Read Results. 
Мишкою відмічаємо 8 підкрок, натискаємо Read і Close (рис. 22). 

 
Рис. 22. Зчитування результатів 8-го підкроку навантаження 

 
Для задання лінії вздовж якої потрібно побудувати криву 

розподілу напружень використовуємо пункт меню General 
Postproc>Path Operations>Define Path>By Nodes (рис. 23). 

 

 
 

Рис. 23. Меню створення лінії між вузлами моделі, вздовж якої будуть 
побудовані криві розподілу напружень (деформацій тощо) 
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Вказуємо перший (рис. 24) і протилежний (рис. 25) вузли лінії і 
натискаємо ОК. Для зручності слід використовувати інструменти 
масштабування моделі, які знаходяться праворуч робочого вікна. 

 
Рис. 24. Виділення першого вузла лінії 

 

 
Рис. 25. Виділення протилежного вузла лінії 

 
У вікні, що з'явиться (рис. 26) навпроти Name Define Path Name 

вписуємо довільну назву лінії, наприклад "line". Значення комірок 
кількості наборів даних nSets та поділу лінії nDiv залишаємо "за 
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замовчуванням" 30 і 20 відповідно. У складніших моделях ці значення 
можна збільшувати. 

 
Рис. 26. Вікно задання імені лінії та її дискретизації 

 
З використанням меню Map onto Path (рис. 27) вказуємо, які дані 

слід виводити на кривій. В нашому випадку інтенсивність напружень 
Stress – Intensity SINT. Крім того, у комірку навпроти Lab User label 
for item вводимо довільну назву результатів виведення, наприклад 
Sint (рис. 27). Натискаємо ОК. 

 
Рис. 27. Вибір результатів розрахунку для побудови кривої 

 
Для виведення кривої розподілу інтенсивності напружень вздовж 

вказаної лінії використовуємо Path operations>Plot Path Item>On 
Graph (рис. 28). У вікні Plot of Path Items on Graph виділяємо ім'я 
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даних SINT, яке ми задали в попередньому пункті. Натискаємо ОК. 

 
Рис. 28. Побудова кривої розподілу інтенсивності напружень вздовж 

наперед заданої лінії 
 
У результаті на екран виводиться крива розподіл інтенсивності 

напружень вздовж заданої лінії на верхній грані стержня (рис. 29). 

 
Рис. 29. Крива розподілу інтенсивності напружень вздовж наперед 

заданої лінії 
 
З рис. 29 видно, що максимального значення інтенсивність 

напружень досягається не у місці консольного закріплення стержня, а 
на деякій віддалі (приблизно 0,05 м) (див. рис. 30). 
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Рис. 30. Поле розподілу інтенсивності напружень біля місця 

консольного закріплення стержня 
 
Різке зростання інтенсивності напружень у протилежному кінці 

лінії є результатом виникнення локальних напружень в околі вузла до 
якого прикладене зовнішнє зусилля (рис. 31). 

 
Рис. 31. Поле розподілу інтенсивності напружень в околі вузла 

прикладання зусилля
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